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Tutorial 1
SiLENSe 6.3 & SiLENSe Laser Edition 6.3

Specifying a New Problem in SiLENSe:

Simulation of InGaN MQW LED Heterostructure



Creating a new project for InGaN MQW heterostructure

Tutorial 1: Specifying a New Problem in SiLENSe

This tutorial shows how to create a new project similar to ‘MQW-example’ supplied with the software, specify 

all necessary input data, run simulations, and prepare input data for SpeCLED. It includes the following 

steps:

Step 1: Choosing material data and creating new project

Step 2: Specification of the heterostructure layers

Step 3: Specification of global parameters (like temperature)

Step 4: Simulation of the band diagram, carrier concentration, carrier transport; inspecting results

Step 5: Simulation of carrier energy levels, wave functions, and emission spectrum; inspecting results

Step 6 (optional): Preparing input data for SpeCLED



Step 1: Creating a new project

Tutorial 1: Specifying a New Problem in SiLENSe

1. Open SiLENSe and press

New button from the toolbar.

A modal window appears where

the user is prompted to browse

a database file (*.matprop) with

materials properties.

2. Choose wurtzite database

supplied with SiLENSe. It

includes properties of AlInGaN

alloy and 3 materials which can

be used as a substrate

(sapphire, SiC-6H, and SiC-4H).

Lists of available materials and

alloys shows data contained in

the chosen database file. Green

mark and red cross indicate

good and insufficient data.

3. Press OK to create the

project.

SiLENSe comes with two databases of material properties, Wurtzite and ZincBlende. The user can edit the data

contained in these databases using a separate Properties Editor (ProEdit.exe) and create new custom *.matprop files.



Step1 (Continued): Materials vs. Alloys in SiLENSe database

Tutorial 1: Specifying a New Problem in SiLENSe

In specification of materials properties, SiLENSe distinguishes between materials of fixed composition (like GaN, AlN,

and InN) and their alloys where composition may be continuously varied with one or more degree of freedom (like

AlxGa1-xN, InxGa1-xN, AlxInyGa1-x-yN). There are 3 options to specify how properties of an alloy are calculated for a certain

composition: (i) linear interpolation + bowing, (ii) built-in parameterization, and (iii) custom user-defined function.



Step1 (Continued): Inspecting material properties

Tutorial 1: Specifying a New Problem in SiLENSe

1. Open Materials Properties tab for

read-only inspection of the properties
3. Select the desired material or 

alloy from the drop-down menu
7. For alloys, there will also be

a group of columns containing

the bowing parameters (see

the next page)

2. Choose between materials

and alloys by switching to the

respective tab

4. View the properties of

selected material or a group

of materials forming the alloy 5. $Par (parameterization) marks the 

characteristics derived from some other 

material properties via theoretical expression. 

The resulting value is shown in the brackets  

6. This column shows how 

properties of the alloy are 

calculated (see comment on 

previous slide)



Step 1 (Continued): Bowing parameters and parameterization

Tutorial 1: Specifying a New Problem in SiLENSe

By default, most properties have bowing interpolation type with zero bowing parameters, that means that linear interpolation

is used to calculate the property for alloy of given composition. compared to the linear interpolation. Positive bowing means

decreasing of the property

It is assumed that user does not need to change properties during everyday work. Instead, it is recommended to work with

the same chosen set of material properties for all simulations for self-consistency of the whole research project. When

necessary, editing of materials properties to be done with Properties Editor tool (PropEdit.exe) which is not discussed in

this tutorial. One can update materials properties by using Materials Properties->Import menu item.

Parameterization interpolation type for alloy means that the property is calculated in two steps: (i) parameters (i.e. some

other material properties) involved in the parametrization equation are calculated according to the alloy composion and then

(ii) the property is calculated with the equation and values of parameters calculated at step (i).

Bowing parameters 



Step 2: Adding heterostructure layers

Tutorial 1: Specifying a New Problem in SiLENSe

Heterostructure tab allows one to specify the heterostructure layers:

1. Press Add Layer button to add a new layer.

2. A pop-up menu appears allowing one to choose belween Materials and Alloys. Both

items contain submenus with list of available materials and alloys.

3. You can choose either Materials->GaN to add GaN layer or, alternatively, Alloys-

>AlInGaN. In the latter case you will also have to specify composition as Al0In0Ga1N.

Note that later you can also copy-paste existing layers to create new ones.

Heterostructure has to start with n-type layer and end with p-type layer. Nucleation and

buffer layers should not be included.

alternative way



Step 2 (Continued): Layer thickness and composition

Tutorial 1: Specifying a New Problem in SiLENSe

2. You can name the layer

for your own convenience

3. Specify the layer thickness. While actual

thickness of the first n-GaN layer is several

microns, in SiLENSe one can use a

reduced thickness of 500-1000 nm. It must

be just several times higher than the

thickness of depletion region

1. Click Edit Layer button

or just double-click the

layer row in the table to

open the window with the

layer properties

4. If AlInGaN alloy was used to create

GaN layer, proper composition should be

specified.

For each alloy layer, composition at

the start point must be specified and

the sum of all fractions should be equal to

unity. (Composition specification will be

discussed in more detail in the next slide)



Additional information: graded composition 

Tutorial 1: Specifying a New Problem in SiLENSe

Click to auto complete the fraction of the

last alloy component when the content of

all other components is already specified.

Layer composition may be specified using a custom function, defined with a script or as a table

which can be imported from a text file. To use a function, choose the function name in the respective

drop-down list. To edit a function, go to Heterostructure->Functions menu item. The auto menu

item means that this component is determined automatically to make total composition equal to 1.

Composition preview button

opens the window with

plotted composition profiles

Filling this column enables

the input of second-order

composition variation

When composition is specified at

both start and end points, linear

composition profile is created



Step 2 (Continued): Specification of the doping and mobility

Tutorial 1: Specifying a New Problem in SiLENSe

Note that dopant concentration means exactly the concentration of the doping atoms, NOT the

carrier concentration which is calculated by the program! Hole concentration in, for instance, III-nitrides

may be ~50 times lower than Mg concentration because of high activation energy.

1. Specify donor concentration

of 2e18 cm-3 and keep zero

acceptor concentration

2. Keep the default values

for both mobilities

3. Accept the changes



Step 2 (Continued): Adding InGaN quantum well layer 

Tutorial 1: Specifying a New Problem in SiLENSe

1. To add InGaN quantum well layer, click

Add Layer in Heterostructure window and

choose Alloys->AlInGaN.

Double-click the new layer to edit it.

Re-name the layer to InGaN-QW and specify the

layer thickness to be 3 nm.

2. Mark this layer as a Quantum Well layer.

3. For each alloy layer, composition at the Start

point must be specified. Here, we consider InGaN

QW with 13% Indium content. Sum of all rows has

to be unity

Blank End point and Middle point columns mean

that composition does not vary across the layer



Step 2 (Continued): Shockley-Read-Hall recombination 

Tutorial 1: Specifying a New Problem in SiLENSe

In SiLENSe, there are two ways to specify the rate of non-

radiative Shockley-Read-Hall recombination. One is direct

specification of the carrier lifetimes due to point defects. The

other way is to use an original model which relates the carrier

lifetimes with the dislocation density. Both mechanisms

contribute to the total non-radiative recombination rate

independently, see Physics Summary for details.

Specify the dislocation

density of 1e9 cm-2

These two parameters describe carrier lifetimes with respect to point defects.

Blank fields mean that this recombination channel is ignored for this layer



Step 2 (Continued): Composition fluctuation and relaxation

Tutorial 1: Specifying a New Problem in SiLENSe

Section Composition fluctuations allows

the user to input parameters related to

Indium composition fluctuations in InGaN

material. Default Un and Up parameters are

35 meV and 15 meV, respectively

Zero degree of relaxation means

that no relaxation occurs in this

layer (by default, heterostructure

is assumed to be grown

pseudomorphically, i.e., all layers

have the same lattice constant)

Alternatively, to assigning the relaxation

degree at the left interface of the layer, the

user can specify the relaxed layer constant

a. It may be also specified using a custom

function or by tabulated data



Step 2 (Continued): Copy, paste and move layers

Tutorial 1: Specifying a New Problem in SiLENSe

1. To add GaN MQW barrier

layer, select n-GaN layer

and click Copy Layer To

Buffer button

2. Select InGaN QW

layer and use Insert

Layer From Buffer

button

3. A copy of n-GaN layer appears below

the currently selected InGaN QW layer (that

is why we have selected QW layer before

inserting a copy), you just need to correct

the parameters of the new layer

These buttons allow one to

move a selected layer up

and down

4. In the same manner, add one

more QW by copying the first one



Step 2 (Continued): Creating periodic structures 

Tutorial 1: Specifying a New Problem in SiLENSe

2. Click Edit Periodic

Structure button

1. Select two

layers, first QW

and the barrier

3. A modal window appears

where the user is prompted to

input the number of periods.

Input 3 and press OK. To

delete a periodic structure,

one should input 0 or 1 period

4. The new periodic structure will be marked

by green color. You can specify several non-

overlapping periodic structures. In this case,

they will be marked by alternating green and

blue colors



Step 2 (Continued): Finalizing the structure

Tutorial 1: Specifying a New Problem in SiLENSe

2. Plots in the bottom part of the window

allow one to inspect the input by visualizing

the variation of key parameters across the

whole heterostructure. Note that in this plot

second-order variation of parameters will

be shown as the linear one

1. Add top GaN barrier, p-AlGaN electron

blocking layer, and final p-GaN layer

following MQW-example.sls file supplied

with the software (this example has several

slightly different versions). Please note that

the top barrier is p-doped because of Mg

diffusion from p-side



Step 3: Specification of polarity

Tutorial 1: Specifying a New Problem in SiLENSe

1. The user can choose one of the standard

heterostructure orientations including nonpolar

and semipolar ones from the drop-down menu.

Respective inclination angle will be shown in the

box below

2. Choosing Custom Inclination Angle

allows one to specify any inclination

angle in [0,180] range



Step 3 (Continued): Temperature and solver options

Tutorial 1: Specifying a New Problem in SiLENSe

3. Keep default values

for solver options. You

can find the respective

details in the manuals

1. Specify the p-n junction

temperature here

2. Quantum potential (QP) model

improves simulation of the carrier

transport through relatively thin

barriers (particularly, in MQW

structures) by a qualitative description

of the quantum effects: tunneling and

quantum confinement.

With the quantum potential model,

steps of the Fermi levels are smaller

and the carrier concentration

distribution is more like one obtained

with quantum-mechanical simulations.

One can adjust the model by changing

two correction parameters or turn off

the model



Step 4: Running the simulation of the band diagram

Tutorial 1: Specifying a New Problem in SiLENSe

1. You can run calculations

for a single bias or …
2. Click to run series 

calculations

5. Run simulations

4. Specify bias range

3. Add sequence



Step 4 (Continued): Consistency of input data and simulation 

results, “locking” of the input data

Tutorial 1: Specifying a New Problem in SiLENSe

In SiLENSe, all completed results are considered

as a part of the project file and saved with it. To

keep self-consistency between the input data and

results, the project input data are “locked” once

at least one result is computed.

For “locked” project, most of the options for

editing heterostructure are disabled. Edit Layer

button is enabled, while most of the layer

properties appear in read-only mode, that is

shown by the grey color of the text fields.

The only properties one can change for “locked”

project is the Layer name, the Active region flag,

and the Usp parameter (since the latter two do

not effect the band diagram simulation)

To be able to edit the input data, one needs to clear all the results by clicking the lock button and thus unlock the

editing.

These restrictions may look strange at the first glance, but they guarantee that simulation results stored in the project file

are always consistent with the input data. So, you do not need to worry about remembering what parameters the results

you see correspond to, you can just check them in the project file.



Step 4 (Continued): Results tab

Tutorial 1: Specifying a New Problem in SiLENSe

2. Please, explore your options 

for viewing the results

1. Note that each item from the

vertical toolbar on the left will have its

own list of variables that can be

shown or hidden



Step 4 (Continued): Neat tricks with zooming and moving

Tutorial 1: Specifying a New Problem in SiLENSe

1. Say, you want to zoom in on a

segment of the plot. Press left mouse

button and drag it across the area of

your interest diagonally from the top left

corner to the bottom right

2. To zoom out to the full

size, move the mouse with

the pressed left button in

the opposite direction

anywhere

3. To move the plot, press

the right mouse button and

drag the plot



Step 4 (Continued): LED results 

Tutorial 1: Specifying a New Problem in SiLENSe

1. To view more results (including I-V curve,

IQE, spectrum, etc.) you can either go to

Window->LED Results or press this button

This button computes peak

wavelengths for all the listed biases

and fills the respective column

Show I-V characteristic

button provides j(U) and

IQE(j) plots



Step 4 (Continued): More LED results

Tutorial 1: Specifying a New Problem in SiLENSe

There are several ways to export the computed

results in ASCII format, try the icons below and

the Export section of the menu

While Export to SpeCLED button can be

used to export of the results for its further

use in SpeCLED, we recommend a newer

alternative option (see step 6)

To compute wave functions and spectrum, select the

row in the table that contains the desired bias (it will get

highlighted blue) and press the button that looks like

spectrum. Once the computations are complete,

Spectrum tab is opened, see the next slide

Injection

Leakage



Step 5: Energy levels, wave functions, spectrum

Tutorial 1: Specifying a New Problem in SiLENSe

1. By default, electron and hole

wave functions for the lowest

energy level in each QW are

shown in the plot along with the

band diagram and Fermi levels
3. Feel free to mark the

levels for the wave

functions you would like to

see visualized in the plot

2. One can switch between the QWs in the list

of QWs and see respective list of energy

levels. Currently selected QW will be marked

with the cyan vertical stripe in the plot. Note

that these marked areas correspond to the

layers you have marked as active region

4. Table with overlap integrals can be

opened by this button or by Window >

Overlap Integrals menu item



Step 5 (Continued): Emission and gain spectrum

Tutorial 1: Specifying a New Problem in SiLENSe

2. You can show/hide

contribution of each QW

into the total spectrum

3. Blue line(s) is the

spontaneous emission

spectrum and red line(s)

is material gain for the

QW layer

1. You can switch between the

photon energy and wavelength



Step 5 (Continued): Detailed spectrum

Tutorial 1: Specifying a New Problem in SiLENSe

Window -> Detailed

Spectrum menu item

opens the window with

complete information

on spectrum resolved

by QW and energy

level



Tutorial 1: Specifying a New Problem in SiLENSe

Step 6: Preparing input data for SpeCLED

Automatic generation of data file according to the user specified variation of both p-n junction bias

and temperature is supported. The output data for SpeCLED are organized as a single *.txt file with

the same filename as the project file. New approach allows running SpeCLED computations with

account of lateral carrier diffusion in the active region and surface recombination.

Go to Run, Series 

Calculation for SpeCLED



Tutorial 1: Specifying a New Problem in SiLENSe

Step 6: Preparing input data for SpeCLED (2)

1. Series computations should cover

your typical range of the p-n junction

bias variation. At the biases providing

current density of interest, the

recommended bias step is 10-50 mV.

Note that with increase of temperature

the p-n junction bias corresponding to

a certain current density becomes

lower.

2. To run SpeCLED simulations with

account for self-heating effects, you

would need to have data for a range of

temperatures that you anticipate in the

device. We recommend using the step

of 5-20K (for instance, T = 300, 320,

340, 360, 380, 400, 420, 440, 460,

480, 500 K)

4. Run button starts calculations

followed by the data export into

the *.txt file.

3. Check this checkbox if you

want the results for each

temperatures to be saved as a

separated project files.



End of Tutorial 1



Tutorial 2
SiLENSe Laser Edition 5.12

Using SiLENSe for Modeling of Lasers:

Simulation of InGaN MQW UV laser diode



Features specific to laser diodes

Tutorial 2: Simulation of InGaN MQW UV laser diode

This tutorial describes simulation of laser diodes. Most of the 

input data specification is similar to LED simulation discussed in 

the previous tutorial. Let us skip options common for simulation 

of LEDs and LDs and focus on features specific to laser diodes:

1. Computation of waveguide modes

2. Computation of threshold characteristics

Options specific for simulation of LDs are located under two 

tabs: Laser parameters and Waveguide



Specifying options specific for LDs 
Computation of the waveguide modes is done independently from computation of the band diagram. However, it

also uses the Heterostructure and Materials properties input data. Laser parameters tab contains a number of

additional input data for simulation of LDs. They are split into two sections specific to computation of the waveguide

modes and to computation of the threshold characteristics, respectively.

Tutorial 2: Simulation of InGaN MQW UV laser diode

Computation of the threshold

characteristics implicitly calls

computation of the waveguide

modes, so both sections

should be specified correctly

even if the user does not run

computation of the waveguide

modes directly!



Unlike the carrier transport in LEDs, waveguide

modes may depend on the substrate. As you

might remember, some reduced thickness is

specified for the first and last layers at the

stage of the heterostructure modeling, because

remote parts of homogeneous bulk n-region do

not affect p-n junction and the light generation.

However, whole first layer and even

substrate may be important for

computation of the waveguide modes

Specifying parameters for computation

of waveguide modes  

Tutorial 2: Simulation of InGaN MQW UV laser diode

To choose the substrate material, click in the

respective input field. A drop-down list will

appear. If the material you choose is an allow,

specification of composition will be required

Substrate usually has a thickness ~100 times

higher than the heterostructure. However,

confined modes exponentially decay in the

substrate. Substrate thickness in computations

should be at least 2-3 decay lengths

Actual first layer thickness allows the user to

specify the real thickness of the first layer. (Not

the reduced one that was used in the

heterostructure tab)



Computation of waveguide modes  

Tutorial 2: Simulation of InGaN MQW UV laser diode

1. Use Run -> Waveguide

Modes to launch computations

from the menu 2. A modal window

appears where the user is

prompted to input the

emission wavelength

3. Next, the user is asked if he/she wants

to compute far-field distribution of the

modes extracted from the laser edge (far-

field is not used in the program, but takes

significant time to be computed)

4. Waveguide tab opens when

computations are complete

5. Refractive index for ordinary

and extraordinary waves is

shown by magenta and cyan

lines, respectively

6. The user can

show/hide individual

modes by the check

boxes. The value

indicates “effective

refractive index” of the

mode (see manual for

details)



Viewing the confinement factors

Tutorial 2: Simulation of InGaN MQW UV laser diode

2. The mode with the highest optical

confinement factor reaches the lasing threshold

first. The table can be sorted with respect to

the optical confinement factor value to help find

the mode which will provide laser generation.

Remember to specify the found mode in Laser

Parameters tab for further calculations

1. One can see a table of optical

confinement factors by using

Window -> Optical Confinement

Factors menu item.



Viewing the far-field intensity distribution

Tutorial 2: Simulation of InGaN MQW UV laser diode

1. Switch to Far field to view

far-field intensity distribution

2. To zoom in on a fragment,

press left mouse button and

drag it diagonally top left to

bottom right

3. To zoom out to the full

size, move the mouse with

the pressed left button in

the opposite direction

anywhere

4. To move the plot,

press the right mouse

button and drag.



Parameters for computation of threshold characteristics

and laser output power beyond the threshold 

Tutorial 2: Simulation of InGaN MQW UV laser diode

1. Go back to Laser

parameters tab

2. Specify dimensions of

the cavity and reflectivities

of mirrors

5. Computations of the threshold

characteristics are done with

respect to a certain waveguide

mode. You need to specify the

polarization (TE or TM) and

Mode index of the mode having

highest optical confinement factor

(see the section on viewing the

confinement factors)

4. Software automatically

computes optical loss due

to free-carrier absorption

and loss at the mirrors.

Additional loss is a fitting

parameter added to the

total optical loss
6. Solver settings for self-

consistent calculation of the

stimulated recombination rate.



Parameters for computation of threshold characteristics

and laser output power beyond the threshold. Additional options 

Tutorial 2: Simulation of InGaN MQW UV laser diode

Options for using imported data

on gain instead of ones taken

from spectrum calculation.

Rarely used option.



Tutorial 2: Simulation of InGaN MQW UV laser diode

Computation flow in self-consistent laser model (1)

Modal gain is computed as a sum of the gain values (at given wavelength) with account of confinement

factors of each QW

Optical losses include:

• Losses on back and output mirrors;

• Free-carrier losses;

• Additional optical losses in waveguide (can be used as fitting parameter)

Threshold is determined by comparing modal gain and total modal losses. Specification of global

parameters (like temperature). Above the threshold, the stimulated recombination is included self-

consistently into the drift-diffusion model as following. In the quantum wells, stimulated recombination

rate is assumed to be proportional to the spontaneous radiative recombination rate, Rstim =  Rrad.

Coefficient  is adjusted in order to fit the steady-state condition that modal gain is equal to total optical

losses. Increase of  leads to lowering of the carrier concentration in QWs and lowering of the gain.

Output laser power equals to the integrated stimulated recombination rate multiplied by the factor

describing losses.

See the next slide for a schematic view



Tutorial 2: Simulation of InGaN MQW UV laser diode

Computation flow in self-consistent laser model (2)

Specification of heterostructure: 

temperature, bias, cavity length, mirrors, etc.

Waveguide 

modes and 

optical 

confinement 

factors

Band diagram and carrier transport 

(drift-diffusion model), Rstim =   * Rrad

Computation of optical modal gain, g, 

and total optical losses, a

Compare gain 

and losses

g  a
Output of results

g = a

Carrier energy levels and wave functions 

(Schrödinger equation), gain spectrum

Increase or 

decrease of 



λ



Computation of laser characteristics

Tutorial 2: Simulation of InGaN MQW UV laser diode

Use Run -> Single Calculation With Laser or Run -> Series Calculation With Laser menu item and specify a bias or a

set of biases similarly it is done for LED calculations (see the previous tutorial).

Drift-diffusion calculations look very similar to LED calculation. The only difference is that stimulated recombination is

accounted for in the QW layers.

As described in the previous slide, the

laser characteristics are computed by

self-consistent solution of the drift-

diffusion model for the carrier injection

into the active region and their

recombination there (including

stimulated recombination) and rate

equations for the number of photons in

the waveguide. So, drift-diffusion

model and laser model are solved

iteratively until the condition “modal

gain = modal losses” is fulfilled with

the desired accuracy.



Laser Characteristics window appears after the end of computations

(later one can open it by using Window -> Laser Characteristics menu item)

First tab of the window contains a table. From the “Power” column, one can see that threshold is somewhere between

4.15V and 4.2V bias or between 170 mA and 200 mA current, respectively. If necessary, one can split this interval by

several bias point by running additional laser computations. Use Export menu to store the table as a text file. Other tabs

of the window contains a number of plots and some additional values.

Similarly to LED results, the band diagram, carrier concentrations, etc. are stored in the project file. One can see them

by using Laser Results window (Window -> Laser Results menu item). It works very similar to LED Results window

described in the previous tutorial, see the next page.

Viewing computed laser characteristics 

Tutorial 2: Simulation of InGaN MQW UV laser diode



Power tab contains a plot of the output

power as a function of current (note that

SiLENSe always assumes the linear

power increase above the threshold)

Viewing the results for threshold characteristics 

Tutorial 2: Simulation of InGaN MQW UV laser diode

Optical Gain/Loss tab

shows variation of the

gain and loss as a

function of current density

Threshold current and

the respective current

density are shown here

Constant contributions to

losses are shown here



Wavelength tab shows

variation of the gain

peak position with the

current density

Viewing the results (Continued)

Tutorial 2: Simulation of InGaN MQW UV laser diode



Viewing the results (continued) 

Tutorial 2: Simulation of InGaN MQW UV laser diode

2. To see the wave functions and spectrum, select the

row in the table that contains the desired bias (it will get

highlighted blue) and press the button that looks like

spectrum. Once the computations are complete,

Spectrum tab is opened, just like in Step 5 of Tutorial 1

1. For more results, go to Window ->

Laser Results menu item

2D carrier concentrations

integrated over all the QWs

Includes Jstim

3. For even more detailed information on

computed spectrum, go to Window -> Detailed

Spectrum. See Step 5 of Tutorial 1 for

screenshots.



Computation of threshold characteristics (old model) 

Tutorial 2: Simulation of InGaN MQW UV laser diode

Old model for computations of

threshold characteristics uses LED

results of band diagram computation.

In this simplified model, where is no

self-consistent account of the

stimulated recombination rate in the

drift-diffusion model.

1. First, one needs to run

computation of the band diagram and

current density for a bias/current

range covering the threshold

bias/current.

2. Then use Run->Laser

Characteristics (Old) menu item.

During computations, the program

seeks for the threshold by doing

following tasks for each bias

- Computes gain spectrum and finds 

its maximum

- Computes the waveguide modes at 

the wavelength of max gain

- Computes modal gain

- Computes optical losses

- Compares gain and loss

Simulation results for the old laser model are similar to that for the model with

self-consistent treatment of the stimulated recombination. The only difference is

that laser output power beyond the threshold is extrapolated linearly by using

differential quantum efficiency estimated from the threshold characteristics.



End of Tutorial 2



Tutorial 3

SpeCLED 2008

Specifying a New Problem in SpeCLED:

Simulation of a Planar Chip



This tutorial shows how to create new project similar to example “Planar

2” supplied with the software, specify all necessary input data, and start

simulations. It includes the following steps:
1. Choosing the die type and specification of the layer thickness

2. Drawing lateral geometry

3. Specification of layers (building 3D geometry from 2D lateral geometry blocks)

4. Generation of the computational grid

5. Specification of the material properties

6. Specification of the active region properties

7. Specification of the heat transfer problem and other global parameters

8. Running the computations

Tutorial 3: Specifying a New Problem in SpeCLED



Select Start -> All Programs ->

SpeCLED 2008 -> SpeCLED

2008 or click start SpeCLED GUI.

You can also use the respective

desktop icon or just clock on the

SpeCLED_RATRO.exe

After SpeCLED GUI is started,

Start Program dialog window

appears. It allows the user to

either start a new project or open

an existing one. A list of recent

projects is available.

Step 1: Opening a new project

Press Start New Project
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Project Configuration window is opened

At the start of a new project, user should first

select the type of the chip to be modeled

Four options are available: planar and vertical dies

with and without a substrate

2. Press Next

1. Select Planar Chip

with a Substrate
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Step 1 (Continud): Choosing the die type 

You can try choosing different types

of the chip. Each time, thorough

description of the chosen chip will

appear in the window below.



Project Configuration window is opened
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Step 1 (Continued): Specification of the layer thicknesses

1. Assign thickness of the semiconductor

layers, electrodes, and pads, and

substrate as follows:

n-semiconductor(a) = 5

p-semiconductor(A) = 0.5

mesa depth (M) = 1.1

p-electrode (D) = 50

n-electrode (d) = 20

n-pad(p) = 10

p-pad(P) = 10

2. Assign parameters describing the

substrate thickness:

top (part of the) substrate(E) = 100

bottom (part of the) substrate (F) = 0

3. Assign relative width of the bottom part

of the substrate ( 1 for straight vertical, <1

for narrowing, >1 for widening):

substrate x-extension = 1

substrate y-extension = 1



Note that the user can also access and edit the

parameters described in this window later at any

time by using Configuration menu item
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Step 1 (Continued): Specification of the layer thickness

2. Press OK

1. Assign vertical mesh for p- and n-

layers, electrodes and pads.

For a vertical substrate with size F equal

to zero, NF can be set to an arbitrary non-

zero value, for instance, to 1.

For p-spreading layer, we recommend

use only 1 step.



Tutorial 3: Specifying a New Problem in SpeCLED

Step 2: Drawing the outlines of the layers

1. Click Geom tab to open a window 

for assigning the 2D die geometry

Main SpeCLED window is opened

To specify the geometry, one needs to draw an

outlines of LED die layers projected onto the

base plane. Particularly, the following die

elements should be drawn:

• n-contact semiconductor layer

• p-contact semiconductor layer

• n- and p- electrodes

• n- and p- pads

• contours of wire bonding

• optional layers: p-spreading (ITO) layer and n-

and p- blocking layers

Note that all coordinates are specified in

microns
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Step 2 (Continued): Drawing a rectangle

1. To draw a rectangular die contour,

click Add Rectangle button. The

cursor will change from a white arrow

to a grey cross

2. Click anywhere on the

graphics window with left mouse

button to specify the left top

corner of the rectangle

3. Release the mouse button. Move the

mouse downwards and to the right. The

temporal rectangle position is drawn in

thin black line while the cursor is moved

4. Click with the left mouse button to

define the rectangle corner. The

rectangle will be drawn in thick lines.

The corner points will be marked green.
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Step 2 (Continued): Editing the coordinates manually

1. To edit the coordinates of the

rectangle corners manually, press

Select button

2. Pick the left bottom point with the

left mouse button. The point will be

marked in white.

3. After the point selection, its coordinates

will appear in the Object Editor on top of the

window. The point coordinates are shown as

two values separated with a space. Change

the values to “X=0 Y=0“ and press the Enter

key to shift the bottom left corner

4. After the point is moved, the point is still

selected. To edit coordinates of another

point, you should first deselect the first one.

Click this point once more to deselect it, or

press Spacebar on the keyboard to clear the

selection, or use Clear Selection button from

drawing toolbar.
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Step 2 (Continued): Editing the coordinates manually

Press the button Show All to zoom

the image to fit the screen

Manually change the coordinates of the other

points to have round values:

(X = 0, Y = 0)

(X = 0, Y = 350)

(X = 350, Y = 350)

(X = 350, Y = 0)
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Step 2 (Continued): Adding an object

Click New object

Choose point form the drop-down menu

When prompted, enter 

the following coordinates: 

X = 225, Y = 115

Inspect the results – a new 

point should appear



Note that Red color of an ending point marks a dangling line

Green color marks an internal point of a contour, in other words, point connecting two or more lines
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Step 2 (Continued): Normal splitting

2. Select the line you want to split

(single left mouse button click near

the line that you want to select)

To draw a vertical boundary of the

mesa, use one of the tools dropping a

normal to the line from a selected

point.

As a result, the original bottom line

will split in two parts and the vertical

line connecting a point and the

bottom line will be added.

Note that the bottom ending point will

be marked green – the point is

shared by several lines. At the same

time, the point in the middle will stay

red as dangling.

1. Click Add Normal

Splitting Existing Line

4. A thick vertical

line will be drawn

3. Select the point that the normal

will start at by clicking on the dot

you created in the previous step
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Step 2 (Continued): Adding another side

1. Go to New object and create

anohter point (X = 230, Y = 130)

To add one more side to the mesa,

repeat two previous steps.

2. Click Add Normal

Splitting Existing Line

3. Select this line by a single

click of the left mouse button4. Click at the point

6. This line will appear

5. The “basis” will be split

in two lines at this point
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Step 2 (Continued): Linking the points

1. To draw a line between two already

existing points click Add Line

2. Select one point

3. Select another point

4. The line connecting the two

selected points will appear

5. Add two more points (X = 244,

Y = 119) and (X = 228, Y = 103)

6. Repeat normal splitting two

more times to complete the

shape



2. Define the circle center (click and

release the left mouse button)

3. Move the cursor from the circle

center. Press the button again and

move the mouse keeping the button

pressed. The current circle position

defined by the current cursor position

will be shown in a thin gray line

4. Release the button to assign the

circle position.

5. Position of the selected circle can

be edited in the Object Editor like

the position of a line. You can edit

three values: center coordinates Xc

and Yc and the radius R

6. Alternatively, you could have used

New object tab to add a circle and

manually edit its parameters
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Step 2 (Continued): Adding a circle to draw n-pad

Set the circle parameters:

(Xc = 290, Yc = 60, R = 40)   

1. To draw a circle

click Add Circle



To draw the p-electrode and p-

pad we need to add several

vertical and horizontal lines

Draw the contours of the p-

electrode using Add Vertical or

Horizontal Line tool with the

following coordinates:

(X = 14, Y = 336)

(X = 14, Y = 14)

(X = 200, Y = 14)

(X = 200, Y = 144)

(X = 336, Y = 144)

(X = 336, Y = 336)

Draw the contour of p-pad using

Add Circle with the following

coordinates:

(Xc = 90, Yc = 265, R = 50)

Tutorial 3: Specifying a New Problem in SpeCLED

Step 2 (Continued): Adding vertical or horizontal lines

1. Use Add Vertical or

Horizontal Line. It will help

you keep the proper angle

of the lines drawn by hand

2. Add a circle here



Now the contours are drawn and

one needs to convert them into a

3D geometry. You have assigned

the thickness of the layer right

after the selection of the chip

type, but the layers there are

listed “by name” (mesa depth, p-

electrode, n-pad, etc.) and the

software does not know “who is

who”. Now we will sort it out by

establishing connection between

outlines and functional elements

As you pick them, they are filled

with the Red color, see below. To

exclude block from selection,

click it again.
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Step 3: Specification of layers

1. Switch to Layers tab

2. All the layers available

in Planar Chip configuration

are listed on the left.

3. Select p-semiconductor

4. Select click inside all

blocks which belong to the

p-semiconductor (i.e. all

zones outside of the mesa)

5. Press Apply



All other chip elements to be specified as follows:

1. p-semiconductor: all area except the etched mesa. The active region area has the same shape as p-

semiconductor. For vertical LEDs, p-semiconductor layer is not specified. It is assumed to cover all the die

area.

2. Electrodes and pads: metallic layers, where distribution of the electric potential and electric current is

computed. It is suggested (but not obligatory) that electrodes are used to represent thin semitransparent

metallic layers, while pads represent thick layers. Electrode layer to be specified even if the contact is thick (in

this case, the electrode might has the same geometry as the respective pad).

3. Wires: areas of wire bonding. They are used only to set up boundary conditions for the electric potential.

Note the following requirements: p-semiconductor has to include p-electrode, which has to include p-

pad, which has to include p-wire. Similarly, mesa has to include n-electrode, which has to include n-pad, which 

has to include n-wire. If optional p-spreading layer is used, it should be inside p-semiconductor and include p-

electrode
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Step 3 (Continued): Specification of layers



Now the die geometry is specified

and you can check it in 3D View.

Click Draw 3D button on the left.

Window 3D View will be opened

The planar die height is much smaller

than its width. One can change z-

scale to inspect fine details

The semiconductor layers and pads

are shown proportional their actual

thickness in microns

The electrode thickness is assumed

to be negligible, so they are shown

with some fixed small non-zero

thickness

One can show or hide die elements

by the respective check boxes

Tutorial 3: Specifying a New Problem in SpeCLED

Step 3 (Continued): 3D view

Feel free to change 

colors of the elements



Switch to the tab window Grid to

generate the computational grid

To generate the grid in a 2D domain,

the user should assign the

fragmentation of the domain

boundaries

In Automatic Mode (All Edges), all

boundaries are split in grid faces of

the same size. It can often serve as

an excellent starting point provided

that the reasonable step of the

boundary fragmentation is chosen.

We recommend choosing a short

boundary and splitting it in several

fragments. The same fragmentation

density will be applied to all the other

lines, see the next page.
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Step 4: Generation of the computational grid

1. Switch to Grid tab

2. Boundaries without

assigned fragmentation

are marked with yellow

circles like this one

3. Select All Edges to

use automatic mode

4. Select some short

boundary

5. Assign 3 intervals

6. Apply



Later, one can manually refine grid by

choosing Selected Edge mode, and

correct fragmentation of several

boundaries.

Please, note that the rougher the grid,

the faster will be your computations and

the lower will be accuracy. We

recommend that you start with a rough

grid, similar to shown on the left, to get

the first solution and inspect it in terms

of possible errors of the input. Once

you are sure that the input is correct, try

refining the grid (for instance, by

assigning more intervals to the same

short boundary you used at the

previous stage) and compare the two

solutions. For estimates, it is often

sufficient to use a rough grid, while for

final results and for studying the effect

of minor changes it is important to have

a detailed grid. Also, note that the grid

should be particularly good at the areas

of high currents or high gradients.
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Step 4 (Continued): computational grid in auto mode

1. The element used to create the grid in

auto mode is marked white



1. To specify materials properties,

choose Materials tab

3. SpeCLED allows specification

of several types of materials:

semiconductor, conductor,

insulator (can be used for

substrate only), and transparent

conductive oxide (can be used for

p-spreading layer only)

2. Press New
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Step 5: Specification of material properties

4. Select Semiconductor

5. When dialog window asking for

the material name will open, type

n-GaN for the material to be

assigned to n-contact layer
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Step 5 (Continued): Specification of material properties

1. New material

is added here

2. When a new material is

added to the list of

materials, its parameters

should be assigned in the

section Properties

3. Each property can be

specified as a constant

value, or as a function of

temperature or coordinates
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Step 5 (Continued): Using a constant value for properties

1. If more than one,

select the material. In

this case, it is n-GaN

2. Select COND for

heat conductivity

3. Description appears,

including required units

4. Select constant

5. In a new dialog window type 150 to

assign the conductivity of 150 W/(m·K)
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Step 5 (Continued): Using functions to specify properties

1. Select MOB_XY for

the lateral mobility

2. Check the description,

particularly, required units

3. Select expression(T)

4. In a new dialog window

type 100*(300/T)5. After you press OK, inspect

the resulting curve
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Step 5 (Continued): Conductors and insulators

1. Add a conductor material for

electrodes and pads. For a Conductor

material, you should assign the thermal

and electric conductivities only. Insulator

material is proceeded similarly with

specification of the thermal conductivity

only.

2. Just like it the previous step,

assign the following parameters:

COND (heat conductivity)

315 W/(m·K)

ECOND (electric conductivity)

4.1105 (Ω·cm)-1



Now, import of the I-V characteristics

calculated by SiLENSe tool will be

used. Description of specification of

parametric dependencies within

SpeCLED will be shown later.
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Step 6: Importing active region properties from SiLENSe

1. Switch to Active

Region tab

2. Select Computed

by SiLENSe

3. Press Load

4. Load the files ivc-300.sct, ivc-400.sct and

ivc-500.sct from Tutorials/IVC directory.

These files contain data on active region i-v

characteristics for T = 300°C, T = 400°C and

T = 500°C, respectively. Multiple file opening

is not available, so you should load the files

one after another.

5. After loading the files, you do not have to

assign any active region parameters but can

view the loaded values (next page)



The files imported at the previous

stage contain the following data:

• Current density as a function of

the bias

• Internal quantum efficiency as a

function of current density

• Emission spectrum for each

bias
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Step 6 (Continued): Viewing the properties from SiLENSe

1. Select I-V Characteristics to

view the current density and IQE

3. Plots for all loaded files are drawn.

The selected plot is drawn in red. The

other plots are drawn in blue

2. Select a file for a

temperature of interest

from the list of loaded

files
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Step 6 (Continued): Viewing the spectrums from SiLENSe

1. Select Spectra to view the to

view the emission spectrum

2. Select a file with the data for

a temperature of your interest

from the list of loaded files

3. Select a bias from

the list of voltages

4. View the emission intensity as a

function of wavelength at the

selected temperature and bias



Parametric approximation can be used

to describe the active region

properties.

Please, read the manual for details

about parametric approximation of j(U)

and IQE(j).
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Step 6 (Continued): Parametric specification of active region

1. Select Parametric

Approximation

2. These parameters describe the

dependence of the p-n junction

current density on the p-n junction

bias, j(U). Feel free to edit the

default set as you wish.

3. Dependence of IQE on the p-n

junction current density, IQE(j). Edit

the default values as you need.

4. In parametric mode,

emission is monochromatic.

Specify the wavelength here.

5. Input of tabulated data for

the active region properties

is also available
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Step 7: Specification of the heat transfer problem

2. Radio group Heat Transfer enables one to switch between

computation of the current spreading at fixed temperature and

coupled problem of the current spreading and heat transfer

1. Select  Run  

3. Input device temperature for

isothermal problem. Otherwise, input

initial guess for the temperature

4. Considering the chip where

substrate is mounted onto the heat

sink, let us specify the heat transfer

coefficient for substrate bottom

surface only. Reasonable default is

1e5 W/(m2K).

For our case, let us keep zero values

for the heat transfer coefficients for

pads. On the contrary, for flip-chip

mounted LEDs one should specify

heat release through the pads.

All other surfaces are always

considered adiabatic



Light Extractions Efficiency is used

to calculate the external quantum

efficiency and wall-plug efficiency.

For simulations with self-heating

effects, it is also used to determine

the heat source related to light

absorption in the chip (it is assumed

that all absorbed light contributes to

the heat source in the active region)

1. Assign some initial guess for Light

Extractions Efficiency (0.25). This value

can be updated after light extraction

computations are made by RATRO
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Step 7 (Continued): Specification of global parameters

2. Select the materials for

the die layers:

p-semiconductor – p-GaN,

n-semiconductor – n-GaN,

p-electrode,

n-electrode,

p-pad and n-pad – Au,

Substrate – Sapphire

2. Having no additional information,

let us keep zero values for the

electrode contact resistances



Before running the computations, do not forget to select the File -> Save As … menu item to save the project

The following modes of running

computation are available:

• Single Calculation

• Series Calculation

• Series Calculation for SimuLAMP
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Step 8: Running computations

3. Run

1. To run a computations for a given

current, use Single Calculation

2. Set current to 100 mA

3. Set parameters of the current

fitting by the voltage variation:

Initial Voltage = 3.5 V

Voltage Step = 0.1 V - a fitting

parameter, can be rather high



1. To run a computations for a given

current range, use Series Calculation

3. Run

2. Specify the following values:

Total Current Min 10 mA

Total Current Max 150 mA

Initial Voltage 3.5 V - initial voltage

is used only for fitting the minimal

current (here, 10 mA) by the

voltage variation

Voltage Variation Step 0.01 V -

step of the I-V characteristics,

should be rather small
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Step 8 (Continued): Running series computations



1. To run a computations for a given

current for SimuLAMP software, use

Series Calculation for SimuLAMP
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Step 8 (Continued): Running computations for SimuLAMP

2. Specify the current range and other

parameters similarly to series calculations

3. Specify the list of chip

temperatures

4. Run



End of Tutorial 3


